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This document outlines the enhancements and additions to the core product for Agile e6.2.1.0 
Release Update Packs.

Enhancements 
This section describes the enhancements included in Agile e6.2.1.0 Release Update Packs

Agile e6.2.1.1 

Java Client
You will find several fixes for the Java Client User Interface behavior in this RUP

? Drop Down menus no longer disappear, when trying to select from filtered drop down lists

? Pre_mask triggers are executed while switching between folders in a form, if /Dynamic 
option is used. 

? Auto-Hide behavior for the browser window has been improved, so that it stays open on 
Mouse Over action and allows to work with the browser window content

? Icons to expand and collapse browser structure do no longer fade out unexpectedly

LogiView

Menu_create  

A new option /RESET is introduced in the LogiView function menu_create to clean the menu 
cache. In Agile e6.2.1 a caching mechanism was introduced for menus to improve the 
performance of the Java Client. However if the menu selections are modified for such a menu, 
the system still reads the old menu entries from the cache.

Using the option "/RESET" allows to clear the cache for the menu, so data is read from the 
database and the cache is refreshed.

Note: Each RUP is cumulative and contains all enhancements and 
additions delivered in prior RUPs.
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LogiView Code Sample:

MENU_NAME = "menu_name" 
SELECTION[1] = "selection1" 
SELECTION[2] = "selection2" 
menu_create(strcat(MENU_NAME, "/RESET"), SELECTION[1])

Furthermore an issue with duplicate titles was fixed when using menu_create with Option 
/Title.

Scan()  

Starting with Agile e6.2.0 the LogiView scan() function had compatibility issues compared to 
Agile e6.1.3. When scanning for example a string that contains characters (e.g. 'X1') and 
converting this into an integer, the return code of scan() function is 0 and target variable is 
unchanged.

See sample LogiView code below:

10 intVar = -1
20 guard = -1
30 str = "X 1" 
40 result= scan(str,"%i %i", intVar, guard) 
50 put("result=",result)
60 put("intVar =", intVar)
70 put("guard =", guard)

Execute this procedure.

result=0
intVar =-1
guard = -1

Snapshot Management
Snapshot Management functionality has been improved to allow creation of snapshots even if 
some documents in the document structure are reserved by another user. Therefore EDB_REL_
ACT_INS supports a new value 4, which skips the checks for "write access to parent" and  
"reserved by other user".

On creating a new document revision, the files belonging to the snapshot are not copied 
anymore if the snapshot is not taken over to the new document revision.

Installer

Modified Database Connect String to successfully connect to Oracle Pluggable 
Database  

The syntax of the database connect string was changed to allow successful connection to the 
Oracle Pluggable database. Now it contains "SID=" instead of "ORACLE_SID=".

To connect to Oracle Pluggable Database, you need to modify the listener.ora file on the Oracle 
Pluggable Database server:
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? Add control parameter "USE_SID_AS_SERVICE_listener_name=on" (e.g. USE_SID_
AS_SERVICE_LISTENER=on) in the listener.ora file.

? Remove the value for the "HOST" in the listener. It should look like this "(HOST=)".

? Restart your listener on the Pluggable Database.

GUI installer log files re-located  

The GUI installer log files are now stored in the temp directory, which is %TEMP% on 
Microsoft Windows platforms and /tmp on UNIX platforms.

Agile e6.2.1.2

Java Client (Bug 27766477)
When opening an object in the Java Client browser, the browser object name shows the full 
object name (e.g. 'Item / Item Number / Revision Number') now. This is also shown as the title 
in the dynamic tab.

Furthermore, if the user tries to open the same object (with identical object name) twice in the 
browser, the already opened object will be closed and the object will be re-opened. You will 
find the new object at the bottom of the browser panel. 

Snapshot Management (ER 27570799)
The Fast Load procedure has been enhanced to provide more detailed information about 
snapshots. When the Fast Load procedure is used to load a CAD snapshot, you will now find 
information about T_DOC_SNP_STR.CAX_01 to T_DOC_SNP_STR.CAX_05 and T_DOC_
SNP_STR.CAX_FILE_NAME in the resulting table T_CAX_STR_TMP.

Userexit EXM_SND_EXT supports parameter -U (ER 28243455)
When using EXM_SND_EXT userexit to use server side mailing, you can use the parameter -U 
to define the user, whose email address is used as "from_user" in the email. Previously the 
parameter -U was ignored and the email was always sent on behalf of the current user.

The behavior of client side mailing remains unchanged.

AutoVue and Support of latest JDK 1.8
Agile e6.2.1 RUP2 will mandate the users to upgrade to AutoVue 21.0.2 which requires 
JDK1.8.0_181 or higher version. 

If customers on Agile e6.2.1.0 GA or RUP1 want to use AutoVue 21.0.2 without applying 
RUP2, they can follow the guide to manually upgrade to AutoVue 21.0.2 (Refer to Support 
Note Doc ID 2491584.1).
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If customers have already applied RUP2, but they still want to use AutoVue 21.0.1, they can 
also follow the guide to manually downgrade to AutoVue 21.0.1 (Refer to Support Note Doc ID 
2491586.1)

Platform Support for Oracle WebLogic 12.2.1.3 (ER 28825014)
? If using Oracle WebLogic 12.2.1.2 with Agile EDM 6.2.1.0, it is strongly recommended to 

upgrade to Oracle WebLogic 12.2.1.3, because Oracle WebLogic 12.2.1.2 is end of Error 
Correction by AUG, 2018 (see Support Note Doc ID 950131.1 for details)

? If using JDK 1.8.0_161 or higher version, two Weblogic patches (28186730 and 
28298734) need to be applied on Oracle WebLogic 12.2.1.3 (See Support Note Doc ID 
2357811.1 for details). We recommend apply latest Weblogic patches.

? Customers can perform a new installation of Agile PLM 6.2.1.0 directly on Oracle 
WebLogic 12.2.1.3 after manually updating the following property file in Agile e6.2.1.0 
GA installer:

<installation-media-path>\installer\properties\iconstants.properties

Please modify the first line as described below (or copy from 
rupInstaller\pkg\installer\properties\iconstants.properties):

PLM_INSTALLER_ORACLE_WLS_VERSION=12.2.1.3.0

? Customers who choose to stay in Oracle WebLogic 12.2.1.2 for Agile EDM 6.2.1 do so at 
their own risk as security patches for Oracle WebLogic 12.2.1.2 are no longer provided. 

? Oracle WebLogic 12.2.1.3 may be a prerequisite for future Agile EDM patches and/or 
RUPs. Customers using Oracle WebLogic 12.2.1.2 for Agile EDM 6.2.1 should upgrade to 
Oracle WebLogic 12.2.1.3 as part of RUP2 uptake, or do so as soon as practical. 

? If you choose to continue using Oracle WebLogic 12.2.1.2 and you encounter an issue, you 
may be required to upgrade to Oracle WebLogic 12.2.1.3 as part of the SR action plan with 
Oracle Support.

Platform Support for Oracle Database 12cR2 (12.2.0.1.0) (ER 21768678)

Database templates have been adapted to be compatible with Oracle Database 12.2.

Database templates of Agile EDM are using Automatic Shared Memory Management (ASMM) 
instead of Automatic Memory Management (AMM) since Agile EDM 6.2.1 RUP 2 (See 
Support Note Doc ID 2244817.1). 

The templates are included in RUP installer package (addon/db/unix or addon/db/windows). 
Please follow instructions in "Installing Database Server in Server Installation Guide" to create 
databases with these templates. The templates should be copied into 
<installation-media-path>/addon in case of database installation by installer.

Note: Manually upgrade or downgrade steps need to be re-done every time 
when re-deploying Jvue and Vuelink.
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Platform Support for AIX 7.2 (ER 28932890)
Agile 6.2.1.0 is certified on AIX 7.2 (PowerPC 7 or higher, 64-bit), but the main supported AIX 
platform for Agile e6.2.1.0 is still AIX 7.1 (PowerPC 5 or higher, 64-bit).

In order to install and run Agile e6.2.1.0 on AIX 7.2 please make the following modifications 
in installation packages:

1. Update the file <installation-media-path>\installer\xml\xmlpropertyextension\os_
specific.xml in the installation package like this:

<Architecture id="UNIX:AIX:7.2" name="AIX 7.2">
<Version id="UNIX:AIX:7.2:ppc" name="AIX 7.2 ppc" EP_MACH="rs6000-ibm-aix7.1" 
Java-Ref="jdk180" Database-Vendor-Ref="ORACLE" Database-Version-ef="ora121"/>
<Version id="UNIX:AIX:7.2:ppc64" name="AIX 7.2 ppc (64bit)" EP_
MACH="rs6000-ibm-aix7.1" EP_MACH_64="ppc64-ibm-aix7.1" Java-Ref="jdk180" 
Database-Vendor-               Ref="ORACLE" Database-Version-Ref="ora121"/>
</Architecture>

2. After installation, change the version in <ep_root>/axalant/scripts/ep_get_mach from 
AIX:1:7 to AIX:2:7 before logging into the Java Client.

3. If you want to use Batch Client to connect AIX 7.2 server, change the version in 
<batchclient_root>/axalant/scripts/ep_get_mach from AIX:1:7 to AIX:2:7.

4. If you want to use the AutoVueBatch to connect AIX 7.2 server, change the version in 
<autovuebatch_root>/axalant/scripts/ep_get_mach from AIX:1:7 to AIX:2:7.

5. If you want to use the EIP to connect AIX 7.2 server, change the version in <eip_
root>/bin/ep_get_mach from AIX:1:7 to AIX:2:7.

Agile e6.2.1.3

Upgrade Tool
BUG 28884474 Oracle Database 12 c Release 2 compatibility Update script CRE_REP_
EDB.SQL has been updated to correct a syntax error which occurred when used with Oracle 
database 12c Release 2.

BUG 29242057 Takeover Western European charsets Additionally the <upgrade 
tool>/ora/sql/creat_upg_correct_utf8_columns_from_byte.sql has been added to make takeover 
work for Western European charsets with BYTE column length semantics. See also Section 
"Preparation of Takeover Production Data in the Upgrade Tool Guide".

Note: There is a platform specific issue on Solaris 11 with Automatic 
Shared Memory Management. An error "ORA-27125: unable to create shared 
memory segment", might occur during database creation with some existing 
templates. Please see support document "ORA-27125 When Creating 12c 
Database On Solaris 11" (see Support Note Doc ID 1584995.1) to solve the 
issue.

Note: Upgrade Tool supports Oracle Database 12.2 starting from 6.2.1.3 
(RUP3).
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RUP Installer Support Silent mode (ER 29479075)
Starting with RUP 3 the RUP installer supports the silent mode installation. In silent mode, you 
can run the RUP installer in batch mode with pre-configured settings. This is extremely helpful 
if you want to install the RUP on various machines. Be aware, except "Database Upgrade" all 
components can be upgraded using silent mode.

Usage of scripts rupinstaller.cmd or rupinstaller.sh to execute "slient" mode is the same, take 
rupinstaller.cmd for example, there are two parameters to input.

rupinstaller.cmd -i|-s [property_file]

The first parameter is mandatory, to define the installation mode. It shall be -i or -s (interactive 
or silent). The second parameter is optional. It defines the property file. By default the 
following file is used batch_install_rup.properties.

When installing RUP in interactive mode, the property file is used to record selections.

When installing RUP in silent mode, the property file is used as input, and it can be copied 
from other machine or edited manually. For the usage of property file, please refer to the 
comments in batch_install_rup.properties.

Web Services to support classification data (ER 28732295)
Web Service calls allow you to access the classification data

In order to retrieve information about the class definition, you can use the existing, generic Web 
Services

? "getObjects webservice allows you to read details about the class object

? "getRelations webservice allows you to read the details about the assigned attributes

Sample webservice calls

Get class definition with getObjects:

<PlmQuery>
<ignoreRecordLimit>false</ignoreRecordLimit>
        <includeAllLanguages>true</includeAllLanguages>
        <includeBinaryValues>false</includeBinaryValues>
        <countOnly>false</countOnly>
        <PlmClass>
          <Name>EDB-GROUP</Name>
          <Mask>EDB-GRP-SLI</Mask>
        </PlmClass>
        <PlmSelection>
          <Condition>
            <Name>T_GROUP_DAT.SML_NUM</Name>
            <Value>1</Value>
          </Condition>
          <Condition>
            <Name>T_GROUP_DAT.CLASS_CODE</Name>
            <Value>CLS-024</Value>
          </Condition>
        </PlmSelection>
        <ReturnFields>
          <Name>T_GROUP_DAT.SML_NUM</Name>
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          <Name>T_GROUP_DAT.CLASS_CODE</Name>
          <Name>T_GROUP_DAT.GROUP_NAME_GER</Name>
          <Name>T_GROUP_DAT.ENTNAM</Name>
          <Name>T_GROUP_DAT.GROUP_TEXT_ENG</Name>
        </ReturnFields>
      </PlmQuery>

Get assigned attribute definition with getRelations webservice:

<PlmRelationQuery>
       <PlmObjectRef>
         <PlmClass>
           <Name>EDB-GROUP</Name>
           <Mask>EDB-GRP-SLI</Mask>
         </PlmClass>
         <Id>
           <PlmAttribute>
             <Name>T_GROUP_DAT.SML_NUM</Name>
             <Type>INTEGER</Type>
             <Value>1</Value>
           </PlmAttribute>
         </Id>
       </PlmObjectRef>
       <ignoreRecordLimit>false</ignoreRecordLimit>
       <includeAllLanguages>true</includeAllLanguages>
       <includeBinaryValues>false</includeBinaryValues>
       <countOnly>false</countOnly>
       <PlmRelation>
         <Parent>EDB-GROUP</Parent>
         <Child>EDB-CLAATTR</Child>
         <Type>REFINE</Type>
         <View>STR</View>
       </PlmRelation>
       <PlmRelationSelection>
         <Condition>
           <Name>T_GRP_CLA.POS_NO</Name>
           <Value>70</Value>
         </Condition>
       </PlmRelationSelection>
       <ReturnFields>
          <Name>T_GRP_CLA.POS_NO</Name>
          <Name>T_CLA_DAT.C_TITLE</Name>
          <Name>T_CLA_DAT.C_TYPE</Name>
          <Name>T_CLA_DAT.C_LETTER_ENG</Name>
          <Name>T_CLA_DAT.C_LETTER_GER</Name>
          <Name>T_CLA_DAT.C_REFERENCE</Name>
          <Name>T_CLA_DAT.C_UNIT</Name>
          <Name>T_GRP_CLA.C_DEF_VAL</Name>
          <Name>T_CLA_DAT.C_CHK_STR</Name>
        </ReturnFields>
      </PlmRelationQuery>

In order to access the classification data, you can use the existing webservice getRelations. It 
will support now reading Classification data. Attributes names can be used as query condition 
to search for classification records. They can also be used as the return fields.

Sample webservice calls

Get classification with getRelations
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            <PlmRelationQuery>
                <PlmObjectRef>
                    <PlmClass>
                        <Name>EDB-GROUP</Name>
                        <Mask>EDB-GRP-SLI</Mask>
                    </PlmClass>
                    <Id>
                        <PlmAttribute>
                            <Name>T_GROUP_DAT.SML_NUM</Name>
                            <Type>INTEGER</Type>
                            <Value>1</Value>
                        </PlmAttribute>
                    </Id>
                </PlmObjectRef>
                <ignoreRecordLimit>false</ignoreRecordLimit>
                <includeAllLanguages>false</includeAllLanguages>
                <includeBinaryValues>false</includeBinaryValues>
                <countOnly>false</countOnly>
                <PlmRelation>
                    <Parent>EDB-GROUP</Parent>
                    <Child>EDB-ARTICLE</Child>
                    <Type>REFINE</Type>
                    <View>ATT</View>
                </PlmRelation>
                <PlmRelationSelection>
                    <Condition>
                        <Name>T_MASTER_DAT.PART_ID</Name>
                        <Value>ITM-%</Value>
                    </Condition>                
</PlmRelationSelection>
                <ReturnFields>
                <Name>T_MASTER_DAT.PART_ID</Name>
                <Name>T_MASTER_DAT.PART_VERSION</Name>
                <Name>T_MASTER_DAT.PART_NAME_ENG</Name>
                <Name>Acc_time</Name>
                <Name>AN</Name>
                <Name>Col</Name>
                <Name>Int</Name>
                </ReturnFields>
            </PlmRelationQuery>

Agile e6.2.1.4

Support of Oracle Database 19c (ER 29635834)
Oracle Database 19c is the recent long-term support release of the Oracle Database 12c family 
of products. Starting with RUP4 you can run Agile e6.2.1 with Oracle 19c Database Server. 

No change for Oracle Database Client. Only 32-bit Oracle Database Client 12cR1 (12.1.0.2) is 
certified in Agile e6.2.1.0 GA and its RUPs.

Support of MS-Office 2019 (ER 28684709)
Agile e6.2.1 Office Suite now also supports Microsoft Office 2019. You can install Office Suite 
on Microsoft Office 2019 using Office Suite 2016 installation package.
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Agile e6.2.1.5

Support WebLogic Server 12c Patch Set 4 (12.2.1.4) (ER 30688711)
Oracle released Oracle WebLogic Server 12.2.1.4 as part of the overall Fusion Middleware 
12.2.1.4 release. This is a patch set release for Oracle WebLogic Server 12.2.1.X, delivered for 
maintenance purposes, incorporating functional and security bug fixes identified since the 
Oracle WebLogic Server 12.2.1.3 patch set release.  It comes with limited new feature content 
between Oracle WebLogic Server 12.2.1.3 and 12.2.1.4 in the interest of simplifying adoption 
of Oracle WebLogic Server 12.2.1.4 by existing Oracle WebLogic Server 12.2.1.X customers.

Oracle WebLogic Server 12.2.1.4 has been designated as a Long Term Support (LTS) patch set 
release. It is important to note that Oracle WebLogic Server 12.2.1.4 has been designated as a 
Long Term Support (LTS) patch set release, formerly known as a  terminal patch set release, for 
WLS 12.2.1.X.  This means that error correction - new patches and Patch Set Updates (PSUs) - 
will be provided for Oracle WebLogic Server 12.2.1.4 for the remainder of support lifecycle as 
published in the Oracle Fusion Middleware Lifetime Support Policy.

Customers adopting Oracle WebLogic Server 12.2.1.4 will be able to leverage 12.2.1.4 as their 
production deployment platform for many years to come. 

Agile e6.2.1.6

Support of High Resolution Screens with Java Client (ER 21934595)
Using the Java Client on high resolution screens had issues as it showed icons and buttons quite 
small. Leveraging the Microsoft Windows 10 high DPI settings it is now possible to scale icons 
and buttons appropriately.

To leverage the configuration settings follow these steps:

1. Locate the JAVA_HOME used inside the  jacc.cmd  file 

? jacc.cmd  file is located in the e6 client installation folder (typically 
C:\ProgramData\Oracle\Agile\EDM )

? JAVA_HOME is usually the 32-bit located at   C:\Program Files (x86)\Java\jre1.8.0_
XXX

2. Go to the JAVA_HOME directory.

Note: The PDF generator is not supported on Microsoft Office 2019 
because Microsoft Office 2019 does not support Agile e6.2.1 supported 
server platforms (Windows Server 2012, 2016).

Note: Refer to Server Installation Guide > Chapter 3 "Installation with the 
Agile e6 Installer" > "Oracle WebLogic Server" section to install Agile 
e6.2.1.0 with Oracle WebLogic Server 12.2.1.4.

Note: If using Java Client Web Start, javaws.exe need to be configured in 
the same way instead.
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? In the [bin] directory, right-click  javaw.exe file, then select  [Properties > 
Compatibility Tab > Change DPI Settings]

3. Tick [Override high DPI scaling behavior].

? From the [Scaling Performed by:] pulldown, select either [System] or [System 
(Enhanced)].

? Then press OK, Apply, and open Agile e6 Client

Note: "Change high DPI settings" option of Java is not available for all 
Windows operating systems.
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Search behavior is configurable when using Quickfilter in Java Client 
(Bug 30907461)
Quickfilter is used to narrow the search results and find relevant entries in a search result list 
more quickly. 

Quickfilter was implemented such that system executed the Quickfilter search, if user did not 
modify the Quickfilter criteria for 100ms. This caused the system to trigger the search although 
the user wanted to specify the criteria further.

Quickfilter has now been enhanced to give customers more control on Search behavior. 
Therefore a new parameter QuickFilterSearchingDelay has been introduced in jacc.defaults.

The following behavior applies for Quickfilter depending on the value for 
QuickFilterSearchingDelay:

? Positive Number: Specifies the time delay in milliseconds before triggering Quickfilter 
search

? 0 : Each key will trigger the search with no delay

? -1 : Search will not be triggered unless the user hits ENTER key

If not specified or invalid value is given, the default value 100ms is set.

Note: This enhancement was addressed by Java 8 u211 or higher version, 
so the configuration change above is only needed when using lower version 
than Java 8 u211. 

Refer to 
https://www.oracle.com/java/technologies/javase/8u211-relnotes.html
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Improved Property Exchange for MS-Office Suite  (Bug 30501376)
New OpenXML SDK will be used in Office Suite to exchange properties between MS-Office 
and Agile e6 in OFFLINE mode, when handling OpenXML document files like .xlsx, .docx, 
.pptx.

We strongly recommend to use OFFLINE mode for property exchange, when using the XML 
file formats for Microsoft Word, Microsoft Excel and Microsoft Powerpoint. Microsoft Visio 
continues to use NATIVE mode only.

Agile e6.2.1.7

Platform Support for Windows Server 2019 (ENH 29616932) 

Agile 6.2.1.0 is certified on Windows Server 2019 with the installer update in RUP7. PDF 
generation of Microsoft Office 2019 is also certified on Windows Server 2019.

In order to install and run Agile e6.2.1.0 on Windows Server 2019, please follow the steps 
below:

Pre-requisition: Microsoft Visual Studio C/C++ Runtime Libraries (32-bit) need to be installed 
on Windows Server 2019.

Update GA installation package:

? Copy file <rup_root>/rupInstaller/pkg/installer/gui/install.exe to replace the file in 
<installation_media_path>/installer/gui

? Copy file <rup_root>/rupInstaller/pkg/installer/xml/xmlpropertyextension/os_specific.xml 
to replace the file in <installation_media_path>/installer/xml/xmlpropertyextension

Support Keepalive for Java Client and PLM-API to avoid connection 
timeouts (ENH 28779484) 

Java Client now supports sending Keep Alive packages to the server. This is sent as an ECI 
function thru either native socket connection or HTTPS connection via PLM-API. The Keep 
Alive packages will ensure connections to the servers stay alive for intervals which are 
configurable in the EDM system.

This feature will solve the issue that some network devices (e.g. routers) trigger security 
tightening when some of TCP connections are idle for long time. But it does not support 
re-connecting the lost client connections caused by network interruption back to their original 
server sessions.

A new parameter is introduced in System --> Other Parameters to enable/disable/define 
interval for Keep Alive feature.

Note: When sending data from MS Office files to EDM, everything is 
transported as a string. We recommend not to use Date fields for property 
exchange, but use String fields instead to retain the same format value. This 
is the same as it used to be with dsofile implementation.
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? Parameter name: EDB-JCL-KEEPALIVE-INTERVAL

? Description: Java Client keepalive polling interval. This system parameter sets the period 
of time (in seconds) after which the system sends the keep alive package via ECI. A value 
of 0 will deactivate sending keep alive packages. The maximum value is 14400 seconds 
(equals 4 hours). This parameter is introduced since e6.2.1.0 RUP7.

? Max-Value: 14400 (Note: Any higher value will be interpreted as 14400.)

? Rubric: EDB-JCL

? Default Value: 0 (Note: The default value disables keep alive package. Invalid 
non-numeric values will be interpreted as the default.) 

How to update EDB-JCL-KEEPALIVE-INTERVAL

1. Login Java Client with a manager credential

2. Choose Other Parameters from System menu to open Configuration form

3.  Search out EDB-JCL-KEEPALIVE-INTERVAL in Configuration form.

4.  Edit to enter your desired Value. Unit is in seconds.

5. Reconnect your client and the keep-alive interval value will take effect

Note:

? EDB-JCL-KEEPALIVE-INTERVAL is a server-side parameter which all clients will fetch 
at login. Therefore, the value change of this parameter will only apply for the clients that 
are connected after the change is made.

? Keep-alive interval parameter can be used independently.

? A short keep-alive interval will lead to more client-to-server polling and may impact 
overall performance. It is not recommended to set it to a small value unless there is a need 
on it (e.g. idle timeout is short.)

Eliminate Weblogic Stuck Issue (BUG 30837125)
There are many reasons that could cause Weblogic stuck issue. Two solutions are implemented 
in order to prevent Weblogic stuck threads.

I. Shutdown idle EDM servers with the Java daemon

PLM-API does not shutdown an EDM server if the client is disconnected without a proper 
shutdown. This will not release resource consumption in the database, EDM server and 
WebLogic.

A new Timeout_Idle parameter is introduced to force the Java daemon to shut down idle EDM 
server connections when reaching the timeout set. The value of the timeout is configurable in 
<ep_root>/axalant/ini/jade.ini file.
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Important:

? This idle timeout parameter must be used together with Keep Alive feature once it is 
enabled. Users will encounter unexpected client disconnection issues if using this idle 
timeout alone without Keep Alive.

? The keep-alive interval value should be less than the idle timeout. This will ensure that the 
keep-alive packages to be sent before reaching the idle timeout that causes client 
disconnection. It is recommended to set keep-alive interval to be half of idle timeout value 
to ensure enough time is given for the server to receive the keep-alive packages and then 
reset the idle timeout timer.

II. Fix the Connector waits forever on callback issue

A new setting "callback.timeout" is introduced in plm-api-eci-server.properties file to prevent 
threads from being stuck.

A reasonable timeout value need to be configured to avoid stuck threads. Usually its value 
should be lower than the Stuck Thread Max Timeout set on the Weblogic.

Below are the steps to configure callback.timeout:

1. Copy <ep_
root>\staging\product\installation\HTTPSupport\WEB-INF\classes\plm-api-eci-server.prop
erties to <ep_
root>\staging\custom\installation\HTTPSupport\WEB-INF\classes\plm-api-eci-server.prop
erties.

2. Edit plm-api-eci-server.properties file under custom directory to set your desired 
callback.timeout value (this value is in milliseconds). The default value of callback.timeout 
is 300000 (5mins).

3. Re-deploy Httpsupport component on Weblogic.

4. After redeployment, the new timeout value will be applied.

Note:

?  If "callback.timeout" is missing or incorrectly set to a string value or no value, the system 
will use the default value 300000 (5mins).

? The "callback.timeout" should never be set to zero (0) to avoid stuck threads.

Recommended Configuration
The values below are initial recommendations to ensure all new parameters work well together. 
You can also tweak the parameters depending on your needs.
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Agile e6.2.1.8

Support of 32-bit Microsoft Office 365 (ENH 32694503 / 28804467 / 
21966797 / 21628454)
Agile e6.2.1 Office Suite now supports 32-bit Microsoft Office 365. You can install Office 
Suite on 32-bit Microsoft Office 365 local deployment using Office Suite 2016 installation 
package.

Support of Oracle 19c Database Client (ENH 32402475)
Oracle 19c database client is supported and mandatory to use for Agile EDM 6.2.1 RUP8 and 
later RUPs. Refer to Server Installation Guide on Window and Unix > Chapter 7 “Oracle 
Database 19c” >"Installing Oracle Database Client" section to install Oracle 19c Database 
Client.

RUP installer will enforce the use of Oracle 19c database for Native Server Component and 
Database. Upgrade will fail if the used Oracle database client is not 19c.

Because Database Upgrade relies on Native Server Components to support Oracle 19c 
Database Client, Native Server Component upgrade should be performed before upgrading 
Database.

Support AutoVue 21.0.2.7 (Bug 33998776)
AutoVue 21.0.2.7 is certified with Agile EDM 6.2.1 RUP8.

JDBC Driver from Oracle Home is not referenced by EIP 
The two settings below in run.conf are removed due to required uptake of 3rd-party libraries. 
Instead, EIP will use embedded Oracle JDBC driver library under %EIP_HOME%/lib 
directory.

++++++++++++++++++++++++++++++++++++++++++++++++++++++
wrapper.java.classpath.10=%ORACLE_HOME%/ojdbc7.jar
wrapper.java.classpath.11=%ORACLE_HOME%/jdbc/lib/ojdbc7.jar

++++++++++++++++++++++++++++++++++++++++++++++++++++++

Remove “examples” folder from Tomcat
The “examples” folder under <APACHE_TOMCAT_DIRECTORY>/webapps is removed due 
to security reason. In case this folder is used in any customization, the backup is retained in 
RUP’s backup folder.

Replace Apache Axis with JAX-WS for EIP Web Services
WebServices and WebService connectors in EIP now run on JAX-WS framework. All Apache 
Axis functionalities have been removed due to security reason. All wsdd related configuration 
(e.g. server-config.wsdd) has been removed.

Refer to Enterprise Integration Platform Administration Guide > Chapter 6 “Network 
Connector” > Web Service Connector and Synchronous Web Service Connector sections for 
more information on configuration.
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Refer to Enterprise Integration Platform Development Guide > Chapter 3 “Web Services” for 
developing and deploying your own Web Services in EIP.

Agile e6.2.1.9

C++ Compiler Upgrade to C++ 11

Agile 6.2.1.9 (RUP9) has been upgraded to use new C++ compilers to supports C++ 11 and 
32‐bit architecture for security compliance. All C third‐party dependencies are also compiled 
and upgraded via the new C++ compilers.

In order to meet the C++ runtime environment requirements, new libraries must be installed on 
the following platforms to run e6. Please refer to Prerequisites Guide, Chapter 4 Operating 
System Requirements and Configurations, for detailed information.

•   Windows - Redistributable C++ 2015 through 2022

•   Solaris - libstdc++.so.6

•   AIX - libstdc++-8-1.ppc

To standardize future upgrades, the resulting e6 artifacts no longer include “_vc10” as a suffix 
in the filenames. The upgrade and standard stated herein require an upgrade of native 
components for all applications. 

Reduce High Consumption of CPU Usage (Bug 33014605)
There are two configurable parameters introduced to prevent or reduce the axalant process from 
consuming high CPU usage when DataView tries to open a faulty LogiView during startup. 
These parameters will give users flexibility when configuring e6 startup.

Parameters:

EDB_EVT_LOOP_LIMIT- If an error occurs during startup in the event status loop. This 
parameter will give the ECI a time limit on how long it should perform the function.

EDB_EVT_LOOP_DELAY- The number of seconds between intervals within the event status 
loop. This parameter will reduce the CPU consumption by delaying the function.

Acceptable values:

•   -1 or undeclared, will void the defined parameter.
•   Any value other than numeric value is considered as 0.
•   Set loop delay to a number of seconds.
•   If the loop delay is 0 and the loop limit has a value, it will set the value to 100 
milliseconds by default.

Example:

EDB_EVT_LOOP_LIMIT=13
EDB_EVT_LOOP_DELAY=3 
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Note:

Enable these parameters when eci_main_loop is causing an infinite loop, viewable in axalant 
logs. This is an issue when DataView tries to open a mask during startup and a logiview is 
defined in <app_name>.xml's edb_init.

Platform Support for Linux 8 (Enh 33002472)
Agile 6.2.1.0 is certified on Linux 8 (64-bit). Linux 7 (64-bit) platform is still supported.

In order to install and run Agile e6.2.1.0 on Linux 8, please make the following modifications:

Here are affected files to support Linux 8.

•   \installer\xml\xmlpropertyextension\os_specific.xml
•   \installer\setup.xml
•   \axalant\scripts\ep_get_mach

1.   Backup the files above so that they can be found back for Linux 7 installation.

2.   Update the file <installation-media-path>\installer\xml\xmlpropertyextension\os_
specific.xml in the installation package like this:

<Name id="UNIX:Linux" name="Linux">
     <Architecture id="UNIX:Linux:OL8" name="Oracle Linux Server 8">
            <Version id="UNIX:Linux:OL8:i386" name="Oracle Linux Server 8" EP_
MACH="i686-linux-ol7" Java-Ref="jdk180" Database-Vendor-Ref="ORACLE" 
Database-Version-Ref="ora121"/>
            <Version id="UNIX:Linux:OL8:amd64" name="Oracle Linux Server 8 
(64bit)" EP_MACH="i686-linux-ol7" EP_MACH_64="x86_64-linux-ol7" 
Java-Ref="jdk180" Database-Vendor-Ref="ORACLE" 
Database-Version-Ref="ora121"/>
     </Architecture>
</Name>

3.   Update the file <installation-media-path>\installer\setup.xml in the installation package like 
this:

<condition property="is.ol8">
     <contains string="${tmp.os.description}" substring="Oracle Linux Server release 
8"/>
</condition>
<condition property="is.ol6">
     <contains string="${tmp.os.description}" substring="Oracle Linux Server release 
6"/>
</condition>
<condition property="is.sles11">
     <contains string="${tmp.os.description}" substring="SUSE Linux Enterprise 
Server 11"/>
</condition>
<if>
      <isset property="is.ol8"/>
      <then>
             <property name="tmp.os.version" value="OL8"/>
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             <propertycopy name="os.version" from="tmp.os.version" override="true"/>
     </then>

4.   After installation, change the version in <ep_root>/axalant/scripts/ep_get_mach from 7.*) 
to 8.*) before logging into the Java Client.

8.*)
     if [ "${FORCE_64BIT_EP_MACH}" == "true" ]; then
          echo x86_64-linux-ol7
     else
          echo i686-linux-ol7

5.   If you want to use Batch Client to connect Linux 8 server, change the version in 
<batchclient_root>/axalant/scripts/ep_get_mach from 7.*) to 8.*).

6.   If you want to use the AutoVueBatch to connect Linux 8 server, change the version in 
<autovuebatch_root>/axalant/scripts/ep_get_mach from 7.*) to 8.*).

7.   If you want to use the EIP to connect Linux 8 server, change the version in <eip_root> 
/bin/ep_get_mach from 7.*) to 8.*).

Support of 32-bit and 64-bit MS Office 2021 and 365 (Enh 26149234 / 
30155960)

Agile e6.2.1 Office Suite now supports Microsoft Office 2021 and 365 (local deployment), both 
32-bit and 64-bit. You can install Office Suite on 32-bit and 64-bit Microsoft Office 2021 and 
365 (local deployment) using Office Suite 2021 installation package.

Agile e6.2.1 Office Suite 2021 only supports Excel, Word, PowerPoint in Microsoft Office 
2021/365. It might work on Microsoft Visio, but it is not certified. 64-bit email client (Microsoft 
Outlook) is not in the scope and yet to be supported. 

To support 64-bit Microsoft Office 2021/365 in Office Suite, IPC (Inter Process 
Communication) is introduced to communicate between 32-bit DLLs in Office Suite Client and 
64-bit DLLs in 64-bit Office applications.

Limitation: "Open from Agile PLM" option in the Office Suite 2021 does not support opening a 
new Java Client session any longer. You'll get an error "Java Client could not be reached" if 
there is no running Java Client session. To avoid this issue, make sure have an opened Java 
Client session before using Office Suite 2021.

A five-second interval is added when the “Open from Agile PLM” or “Save to Agile PLM” 
actions are performed multiple times. This ensures the IPC can properly pass multiple requests 
and process them synchronously to the client via ECI. A slight decrease in performance is 
expected due to this change.

Office Suite IPC Logger

A new logger is implemented for IPC component in Office Suite 2021. The logger adds a 
property file (officeipc.properties) to the Office Suite 2021 installation path to allow 
enable/disable logging.

Parameters:
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•   logFile=<path/filename> 
•   Complete path with IPC logger filename

•   enableLogging=<true/false>
•   To Enable/Disable Office IPC logging, the default is set to false

Newly introduced error messages for Office Suite 2021:

1.   Failed to create the file or directory: <Exception>: Error occurs when attempting to 
enter an invalid path into the logFile field of officeipc.properties

2.   Failed to read the property file: <Exception>: Error occurs when the 
officeipc.properties was not found in the (Agile e6.2.1 - Office Suite for Microsoft Office 
2021) installation folder.

3.   An error occurred while initializing Messaging Service: <Exception>: Error occurs 
when the Messaging Service (IPC) failed to initialize.

4.   Java Client could not be reached: <Exception>: Occurs when there is no Java Client 
session.

5.   Failed to receive the message from Office Suite: <Exception>: Occurs when e6 server 
failed to read/receive the message from Office Suite.

6.   Failed to send the message to e6: <Exception>: Occurs when the Office Suite failed to 
send the message to e6 server.

7.   Could not find path <GdmOfficeIpc.exe> : <Exception>: GdmOfficeIpc executable 
was deleted or not found.

De-Support
This section describes any features de-supported for Agile e6.2.1.0.

Agile e6.2.1.1

Web Client
The Web-Client will be de-supported. Oracle will keep the existing functionality of the Web 
Client but will not provide any further fixes. Customer who are using the Web Client should 
use the Java Client (WebStart) instead or should leverage the web service interface to build 
dedicated Web Frontends for specific use cases.

By default the Web Client start screen shows a de-support message.



20

If you want to de-activate this warning message, please execute the following steps:

1. Copy web.xml from WebPresentationService to <ep_
root>\staging\custom\installation\WebPresentationService\WEB-INF

2. Change the parameter configuration in web.xml. Set the param-value to "false" under the 
param-name "showDeSupport".

3. Redeploy WebPresentation service.

4. Login Webclient, the de-support message disappear from login page.

5. Redo step 2, set the param-value to "true" or others.

6. Redo step 3, 4, the de-support message is shown on the login page with red color.

Agile e6.2.1.5

Platform Support
According to Microsoft, support for Windows 7 ended on January 14, 2020.

Taking this into account and effective with Release Update Pack 5 (RUP 5) for Agile e6.2.1, 
Oracle will end support for Windows 7 platform for Agile EDM product line.

Oracle strongly recommends to upgrade to Windows 10 platform.

If you intend to continue to use Windows 7 platform, please be aware that we will not deliver 
further bug fixes for the Windows 7 platform.

Agile e6.2.1.8

Compress Zip
“Compress Zip” option from System menu > Office Suite > File Types is deprecated. The 
checkbox of “Compress Zip” option is de-activated and not editable. The checkbox will be 
removed in future RUP.
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Internal Browser
Internal Browser is deprecated. The checkbox “HTML help viewer” is removed and “External” 
option is set by default and cannot be unset. All hyperlinks will be opened with external default 
browser.

Settings can be seen on Preferences > HTML Browser:

Web Client Component
The de-supported Web Client components (AgilePlmWdt, AgilePlmWps, 
DaemonAdminServlet) are removed from RUP package. This removal doesn't impact existing 
deployments of these three components.

Here are the removed parts.

? <RUPInstaller_Directory>/packages/daemonadminservlet.zip

•   axalant/bin/java/DaemonAdminServlet.war
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? <RUPInstaller_Directory>/packages/webclient.zip

•   axalant/bin/java/AgilePlmWps.war

•   axalant/bin/java/AgilePlmWdt.war

XMLRPC Connector
XMLRPC connector and all EIP functions built on it are deprecated and removed from EIP

Agile e6.2.1.9

HP-UX Platform
HP-UX platform is no longer supported starting from RUP9 because HP has not provided a 
compiler that supports C++ 11 yet. Agile EDM will not support HP-UX platform until HP 
resolves this issue.



23

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.
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